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Learning Objectives
•
•
•
•

Discover the new Infrastructure Parts Editor software and how it can be used to
help advance your models
Learn how to use existing built-in parts to create custom infrastructure model
content
Learn how to model your very own parametric shape content to build custom
infrastructure model content
Discover how to use Inventor® and the Inventor® Plug In, Infrastructure Part
Shape Utilities, to extend the built-in part library with custom parametric models

Description
Discover the new Infrastructure Parts Editor software and how it can help you build custom
parts for your AutoCAD® Civil3D and InfraWorks® models. This new software, formally known
on the Autodesk Labs as Project Kameleon, enables the authoring of Inlets, Manholes, Culverts,
Frames, Grates, End Treatments, and more. Learn how to use the Parts Editor to use a built-in
shape library of parametric shapes to create custom parts. Discover how to use Inventor® and
the Inventor® Plug In, Infrastructure Part Shape Utilities, to extend the built-in part library with
custom parametric models, and lastly add part sizes through the Infrastructure Parts Editor.
Finally, learn the steps and workflow of bringing these parts into AutoCAD® Civil 3D software
and InfraWorks® software for use on an existing model.

Speaker(s)
Steve Hill is an Autodesk™ AutoCAD® / AutoCAD® Civil3D Certified Professional who has
eighteen years of professional experience in Autodesk™ products and site civil design with an
array of project types including subdivision design, road reconstructions, streetscapes, shopping
centers, rail spurs, natural gas wells/pipelines, and landfill design. His project design experience
includes various stages from overall planning to the detailed construction including site design,
site grading, complex volume calculations, utility and pond sizing, soil erosion control measures,
and details. Hill also maintains a strong background in computers and resolving issues on
multiple operating platforms. With his LLC, Red Transit Consultants, he is passionate about
developing applications and workflow management tools for AutoCAD®, Civil 3D, and Map 3D®
as well as small Windows stand-alone applications with various programming languages.
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The new Infrastructure Parts Editor Software
The Infrastructure Parts Editor (IPE) is a parametric shape editing tool for creating parts
catalogs that are compatible with Autodesk InfraWorks® and AutoCAD® Civil 3D. (Autodesk,
2017). IPE graduated this year from Autodesk Labs previously known as Project Kameleon.

Terminology
Part Catalog: A collection of part families containing the definitions of all the parts that can be
inserted into a model or drawing. (Autodesk | Civil 3D, 2017)
Part Family: A group of similar parts that vary by size. Each part in the part family uses the
same general shape, with both geometric and non-geometric properties varying across the size
range. (Autodesk, 2017)

Where to Find the Software
The Infrastructure Parts Editor is installed with AutoCAD® Civil 3D and InfraWorks® (minimum
2018.1 is required). The software installs as a standalone application that can be opened
without having AutoCAD® Civil 3D or InfraWorks® open, however, there are buttons in both
software that allow for launching IPE. Here are the three ways to launch the program

Windows Start:
1. Click Start
2. Go to All Programs, Autodesk, Autodesk Project Infrastructure Parts Editor;
alternatively, you can type in Infrastructure Parts Editor to find it.
3. IPE launches and opens to the Catalog tab.

Autodesk InfraWorks®:
1. Open Autodesk InfraWorks®
2. Open an Autodesk InfraWorks® model from InfraWorks® Home

3. Click

4. Click

5. IPE launches and opens to the Catalog tab.

AutoCAD® Civil 3D:
1. Open AutoCAD® Civil 3D 2018 (minimum
2018.1 installed)
2. Open a drawing file.
3. On the home tab, go to the Create Design
Panel, and select the drop down
4. Click the Infrastructure Parts Editor button
5. IPE launches and opens to the Catalog tab.
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Overview of Infrastructure Parts Editor
Upon opening, you’ll see a screen like below. In the upper left, there are three main tabs,
Catalog, Parts, and Publish.
Catalog tab is for opening catalogs via file or model, and saving catalogs.
Parts tab is for editing the parts within an open catalog.
Publish tab is for publishing the edited catalog.

Catalog Tab
IPE can be utilized to manage part catalogs for both Pipe Networks and Pressure Pipe
Networks. It can be also used for managing Bridge components and other shapes for
Autodesk InfraWorks®.
In the screenshot below, notice the two domain categories shown are for Drainage
Structure and Piping. In my opinion, this is slightly confusing from AutoCAD® Civil 3D
terminology as currently in IPE, you cannot build custom pipes for Pipe Networks. It is
better to think of the Drainage Structure domain as Pipe Networks (structures only), and
the Piping domain as Pressure Pipe Networks (fittings, appurtenances, and piping).
From the Autodesk Help:
Drainage Structure catalogs are composed of Inlet or Access Structures, Grates or
Covers, Underground Structures, and Pipes or Culvert Barrels.
Piping catalogs are composed of Olets, Fasteners, Flanges, Instruments, Fittings, Pipes,
Valves and Operators, and Miscellaneous parts.
For this class and sake of time allowed, we’ll only be looking at the Drainage Structures.
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Note the help button on the left – this will open up an internet page that has a growing
amount of information about IPE. This will be helpful in the future.

Parts Tab
After opening up the Generic Drainage Structure – Imperial catalog, notice the tab is
now switched to the Parts Tab, as the parts are stored inside a catalog. Here you’ll find a
Navigation Panel on the left and an Overview of images on the right, like the image
shown below.

In the Navigation Panel, at the bottom there are three primary buttons that control the
display of the Navigation Panel: Assembly, Structure, and Culvert. Structure is the
default selection when entering the Parts tab.

With Structure category selected, in the Navigation panel under Part Families, notice
that the part families are divided into three classes: Surface Structures, Underground
Structures, and Grates or Covers. It’s important to understand how these classes are
used.
Surface Structures are the primary controlling feature in a part family and is the portion
of the structure used to place a part on a surface. Surface structures include the frame in
which the grate or cover would site on and parts of the surface structure would be visible
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from the surface after constructed. These are the primary components that drive in
creating the overall assembly.
Select this category to see images of what’s available:

Underground Structures are the portion of the structure that are underground and would
not be seen after constructed.
Select this category to see images of what’s available:

Grates or Covers are only the grate or cover access into the structure and are typically
visible from the surface after constructed. These do not include the frame that the grate
or cover sits on.
Select this category to see images of what’s available:

These three components can be combined together to create an Assembly – items in
the Structure category currently can be used in both AutoCAD® Civil 3D and
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InfraWorks®. Selecting any of the part families within these classes will bring up the
details about that item for editing. For more on this functionality, see the section in this
document Using Existing Built-in Parts to Create Custom Infrastructure Model Content.

With Culvert category selected, in the Navigation panel under Part Families, notice that
the parts are divided into two classes: Pipes or Culvert Barrels and Culvert End
Treatments. It’s important to understand how these classes are used.
Pipes or Culvert Barrels are simple pipes or culverts. The out of the box installation
comes with Box Pipe and Circular Concrete Pipe.
Select this category to see images of what’s available:

Culvert End Treatments are head walls, flared end sections, wing walls, and energy
dissipaters that attach to the end of a pipe.
Select this category to see images of what’s available:

Like the structure components, these two components can be combined together to
create an Assembly, however, it’s important to note that currently these can only be
used in InfraWorks®. Selecting any of the part families in these two classes will bring up
the details about that item for editing. For more on this functionality, see the section in
this document Using Existing Built-in Parts to Create Custom Infrastructure Model
Content.
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With Assembly category selected, in the Navigation panel under Part Families, notice
that the parts are divided into two base types: Inlets or Access Structure and Culvert.
Inlets or Access Structures, as previously mentioned, are the combined assembly of a
Surface Structure, Underground Structure, and a Grate or Cover. The items in this list
are the part families that would be published in the part catalog and would be available
for use in AutoCAD® Civil 3D or InfraWorks®.
Culverts, as previously mentioned, are the combined assembly of a Pipe or Culvert
Barrel (or multiple) and a Culvert End Treatment. The items in this list are the part
families that would be published in the part catalog and would be available for use only
in InfraWorks®.
Selecting any of the part families in these two base types will bring up the details about
that part family for editing. For more on this functionality, see the section in this
document Using Existing Built-in Parts to Create Custom Infrastructure Model Content.

Publish Tab
The publish tab is strictly used when a catalog is ready to be published. Selecting the
Publish button launches a selection dialog to all for publishing all or specific Assemblies
from the Parts tab.
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After selecting Assemblies (Part Families) to publish from the list, choosing Next will
bring up the following dialog. Here you can choose to publish to InfraWorks® or
AutoCAD® Civil 3D or both at the same time.
A few key points to note about this dialog:
1. The errors at the top – click the blue arrow to read information about any present
errors.
2. For InfraWorks®, we can publish to the shared content folder or directly to a
specific model.
3. For AutoCAD® Civil 3D, we can publish our catalog to a different directory other
than the provided out of the box directory – we just need to remember to set the
Pipe Network Catalog to the proper directory to find the parts.
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Using Existing Built-in Parts to Create Custom Infrastructure Model
Content
Create a New Part Catalog
If you’d like to begin with an empty catalog and add in desired Part Families you can do so by
creating a new part catalog. This could be helpful if you’d like to only have a catalog of specific
parts for a project. To create the new Part Catalog:
1.
2.
3.
4.

On the Catalog tab, Click New.
Select the Drainage Structure or Piping Domain.
Click Create.
Specify the Catalog name, storage path, Description, and units of measurement, then
click ok.

Note: Catalogs must have a specific unit and cannot contain part families of mixed units.

Add or Modify a Part Family
Once a Catalog is open, you can add or modify a Part Family as needed.
1. Select either Structure or Culvert button at the bottom of the Navigation pane, depending
on the type of part family you plan to add or modify:
1. Select a part family and the area right of the navigation pane will show tabs with
various properties of the part family.

2. Or, Select the class type (Surface Structures, Underground Structures, Grates or
Covers), then click the new button; the part family will be created and the area
right of the navigation pane will show tabs with various properties of the part
family.
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Add or Modify a Part Family Properties
When a part family is selected or newly created, on the Part Family Properties tab, we
can verify the Part Category and the Part Class – but cannot edit these values as they
are preset based on what class was selected when the part family was created. We can
however control the part family name. It’s recommended to have a unique name that
correlates to the shape of the part and the range of sizes offered. This can be edited at a
later time if needed.

Review or Modify Shape Details
With the Shapes tab selected, here we can specify the Parametric shape. By default, the
parametric shape begins to pull from the library of shapes we have. Hover the cursor
over a shape to display an enlarged preview of the shape. You may select one of the
shapes already available, or choose to define a New Shape Template.
To define a New Shape Template, choose New Shape Template and locate the
Inventor® .IPT file from your local system. A preview will appear with the shape and the
Parameters key dimensions exposed from the .IPT file.
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Modify Detailed Part Family Properties
With the Detailed Properties tab selected, a number of attribute fields will appear
depending on which type of part family that is selected. The Part Family Global Name is
the only item that is required, all others are optional.

Add or Modify Part Sizes
On the Part Editing tab, the Part Editing table allows for adding and removing size
variations, represented in the table as rows. Each column adjacent to the Part Size Local
Name represents dimensions for that part. Dimensions with a single asterisk, such as
*SPDiameter, are required parameters.
Optionally, we can Export the table to Excel and modify the data there. When finished
and saved, we can Import the Excel table back and the Part Editing table will update
accordingly.
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Validate Part Family Sizes
On the Size Validation tab, we have a Size Table and a Size View. As each row in the
table is highlighted, we can visually see the model in the Size View adjust to the
dimensions entered for that row on the Part Editing tab. This allows for validation that the
sizes entered were entered accurately. The Size View can be selected and we are able
to orbit the view to see the part from various angles.

Add or Modify Assemblies
Once a Catalog is open and the catalog contains at least one part family each of the class
components for either the Structure or Culverts domain, an Assembly can be created.
To create an assembly, you must begin with a base part family. The base part serves as the
master size table for the assembly, controlling the size selection, orientation, size matching
requirements, and insertion positioning for the assembled part. For Inlets and Access
Structures, the base part type is a Surface Structure. For Culverts, the base part is Pipe Or
Culvert Barrel.
To Add a new Assembly:
1. Select the domain Inlet or Access Structures or Culver
2. Click the New button
To modify an existing Assembly, select the part family you wish to modify.
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Choose the Base Part
With the Base Part tab current, Select the Base Part Type – this should default to the
correct selection based on what domain was selected. Choose the graphic of the base
part family you desire to use. Enter in the Assembly Name (part family name)

Choose the Components
With the Components tab selected, drag parts from the Matching Parts section and drop
them over to the corresponding location in the Assembly View section. Warning symbols
that appear on the matching parts signify that there may be part sizes that do not match
the offered base part sizes – it does not mean that the part will not match up.
Additionally, it’s important to note that this view will not tell you if a specific part will not
match a base part.
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Modify the Detailed Properties
On the Detailed Properties tab, edit the Part Family global name, if desired and a short
description about the part family. If the part family is an Inlet, check the box, otherwise it
will be placed in an Access structure folder on export. Also, if the part family has a sump,
check the box to allow for that property to be provided.

Validate the Part Family Sizes
The Size Validation tab shows the sizes from each Assembly matched item and the
sizes it found to match. Sizes that do not match will be shown in red. Select a size to see
the Assembly view show a preview graphic of the part at that selected size.

Page 14

Modeling Custom Parametric Shape Content to Create Custom
Infrastructure Parts
One of the great features of Infrastructure Parts Editor is the ability to generate your own
parametric content catalogs for use in AutoCAD® Civil 3D or InfraWorks®. However, in order to
do so, there are some important items discussed in this section to get started.

Autodesk Inventor®
In order to create parametric models for importing into Infrastructure Parts Editor, you will need
to have Autodesk Inventor® installed with the free Infrastructure Part Shape Utilities add on that
comes with Infrastructure Parts Editor. Currently, Autodesk Inventor® is not included in any of
the Infrastructure Suites or AEC Collections. Autodesk Inventor® is currently available standalone or as part of the Product Design & Manufacturing Collection. Additionally the software can
be rented on a monthly basis.

Basics of Autodesk Inventor®
In order to use Autodesk Inventor®, one will need to have a basic understanding of 3D modeling
and understand some key basic concepts of Autodesk Inventor®. Some of these key concepts
are listed below with a general explanation of each.

Cartesian Coordinate System
Autodesk Inventor® uses a Cartesian coordinate system in a three-dimensional space
“in which the location of a point is given by coordinates that represent its distances from
perpendicular lines that intersect at a point called the origin.” (Dictionary.com, 2017)
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Work Planes
Work planes are a key feature to help constrain your model to part of the Cartesian
coordinate system or another object. When starting a file we are provided with three
work plans tied to the coordinate system: YZ Plane, XZ Plane, and XY Plane. All other
work planes and model features will be rooted from these planes.

Sketches
Sketches are used to define a 2D shape for extrusion and must be started from the face
of an object or a work plane.

Parametric Constraints
Parametric constraints are added to sketches or extrusions to define how various
components can be adjusted within the model and how they should interact with other
components.

3D Objects
3D objects are created by select the profile from a sketch and then defining the length,
rotation, and type of extrusion that should take place.

Infrastructure Parts Editor Autodesk Inventor® Template
Currently, a specific template for using Autodesk Inventor® to model parts for Infrastructure
Parts Editor is not provided. There are key items that could be added to a template prior to
starting modeling to help streamline the process – they are listed below:

Autodesk Inventor® UCS
By default, the top view is set to look down on the Y axis, this is backwards for
Infrastructure parts as objects we should be looking down on the Z axis.
Top View – Wrong

Top View – Right
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To set the view correctly:
1. Rotate your view to the correct image shown on previous page – in the
Standard.ipt template this is set as Front View.
2. Select the drop-down arrow by the view cube

3. Then choose Set Current View as Top

Parameter Names
If desired, one could enter in all the appropriate parameter names for use into the
Parameters window and save it to a template. The preferred parameter names are listed
on the next page.
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List of Preferred Parameter Names to Use
This list was provided on one of the most recent Civil Community Presentations and lists the
preferred parameter names for Structure modeling.

Class Type

Parameter

Value Description

FlangeTh

Base Flange Thickness

Cover or
Grate

Underground Structure

Surface Structure

WallTh
Wall thickness of Inlet
CrossSlope
Roadway Cross Slope
GutterSlope
Roadway Gutter Slope
SSHeight
Height of Inlet
SSDiameter*
Diameter of Inlet
SSWidth**
Width of Inlet
SSLength**
Length of Inlet
SPDiameter*
Structure Port Diameter
SPWidth**
Structure Port Width
SPLength**
Structure Port Length
CGDiamter*
Diameter of Cover
CGWidth**
Width of Cover
CGLength**
Length of Cover
CGHeight
Height of Cover
WallTh
Wall Thickness of Catchment Structure
BaseTh
Base Thickness of Catchment Structure
USHeight
Height of Catchment Structure
USBaseHeight
Base Height (region where pipes connect)
USDiameter*
Total Diameter of Structure
USWidth**
Total Width of Structure
USLength**
Total Length of Structure
SPDiameter*
Structure Port Diameter
SPWidth**
Structure Port Width
SPLength**
Structure Port Length
CGDiamter*
Diameter of Cover
CGWidth**
Width of Cover
CGLength**
Length of Cover
CGHeight
Height of Cover
*For round objects only
**For rectangular objects only
Bold parameters above are used to match up the assembly in Infrastructure Parts Editor
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Infrastructure Part Shape Utilities
Infrastructure Parts Editor automatically will create your model assemblies and it is able to do
this because of the tools provided with the Infrastructure Part Shape Utilities.

Assign Cover/Grate allows for applying an image for cover or grate
objects. Start the command, select a face, choose Cover, Grate, or
Remove, and choose the rotation angle.

Pipe Connector allows for adding connection points
where a pipe would connect. This tool is helpful for
designing Pressure Pipe Fittings and defining
where they connect to a pipe.
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Assembly Connector allows for adding connections
to drainage structure parts so they can be assembled
together properly. The dialog has four port names
listed below, only two are actually for drainage
structures, italicized below.
Connector
GrateOrCoverPort
PipeOrCulvertPort
UndergroundStructurePort

Reference Point allows for adding additional
Reference points to parts so that they can be
adjusted and snapped to at these locations
within AutoCAD® Civil 3D or InfraWorks®.

Export Template command exports the part along with
the necessary images and XML files in order for
Infrastructure Parts Editor to process the part.
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Model Oil Water Separator
1. Open Autodesk Inventor® and start with a template setup with at least the UCS settings
explained above, ensuring that your top view is looking down on the Z axis onto the XY
plane.
2. On the 3D Model tab choose Start 2D Sketch.
3. Select the XY plane to connect the sketch to.
4. On the Sketch tab, choose Rectangle Two Point Center.
5. Snap to the yellow center point and drag out diagonally. Before clicking a second point,
type in “SPLength = 78”, hit the TAB key and enter “SPWidth = 48”. Hit ENTER when
done.
If you accidentally, clicked and place the rectangle, you’ll see green lines (nonconstrained). You can do the following to constrain them:
a. From the Sketch tab, select the Dimension button, click on the longer green line
and click again somewhere to drop the dimension. Then type in “SPLength = 78”.
b. From the Sketch tab, select the Dimension button, click on the shorter green
lines and click again somewhere to drop the dimension. Then type in “SPWidth =
48”.
6. Next, from the Sketch tab, select the Offset button. Select the line of the rectangle and
drag inward. Before clicking, type “WallTh = 4” and hit ENTER.
7. Once you are complete and the sketch looks like below, click Finish Sketch.
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8. Next, double click the middle mouse button to Zoom Extents, and orient your view so
you can see the sketch on an angle.
9. From the 3D Model tab, select Extrude. A dialog will appear.
10. Select the profile button and choose the gap from the above image that represents the
4” wall thickness. See screenshot below for the direction button to click.
11. Change the extrude direction to downward so you are extruding towards the bottom
view. See screenshot below for the direction button to click.
12. In the distance text box, clear out the value there and type “USHeight = 60”. Click ok.

The model should now look something like this:
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13. Rotate you view so you are looking at the bottom of the structure. From the 3D Model
tab, choose Plane Offset from Plane.
14. Select the bottom face of the model in the area of the 4” Wall thickness. Leave the offset
value as 0 and click the green check mark.
15. Next, from the 3D Model tab, choose Start 2D Sketch and select the work plane created
in the step above.
16. From the Sketch tab, choose the Project Geometry button. Hover over the 4” Wall
thickness area until all the lines of the model turn white, then left click. The lines will turn
yellow, right click and select Ok. Click Finish sketch when done.
17. Next, we’ll Extrude the Floor of the structure. From the 3D Model tab click Extrude. For
the Profile, select both the Wall face and the center void area of the structure. In the
Distance text box type “BaseTh=7”. Click ok. Your model should now look something like
below:
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18. Next, we need to model the baffle and weir walls inside the structure. To do so, we can
edit our view to help sketch the objects. In the model browser, make sure the Origin
folder is open, then from the 3D model tab, click Start 2D Sketch. Select the XZ plane
from the model browser. You should now be oriented to the front view and look
something like this:
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19. Click on the View tab and click the button Slice Graphics. Your view should now look like
the image below, so you can easily draw the walls in.

20. Next, from the sketch tab, we’ll draw three rectangles representing the baffle and weir walls.
The two baffle walls we will draw first – these can be two floating rectangles not touching
any walls – use the Sketch tab, Rectangle Two Point and draw something like below.
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21. Next, draw the weir wall like shown below – except snap to the top of the floor as this wall
should be connected to the floor.

22. Next, we’ll want to constrain each of these walls – but we’ll want to do so from the center of
the walls. To do so, we need to add construction lines. From the Sketch tab, on the Format
panel, choose the construction line format button. See screen shot below:

23. With the construction lines format selected, use the Line command from the Sketch tab
and snap to the center of each top of wall and snap perpendicular to the bottom of wall.
Right click and choose ok when done.
24. Next, let’s constrain the thickness of each of the walls to the Wall Thickness parameter
created previously. To do this, click the Dimension button from the sketch tab, select the
top line of a wall, pull off the dimension and drop it. In the Edit Dimension dialog, use the
arrow button on the right side of the text box, choose List Parameters, and select
“WallTh”. You could also type this in if preferred. Click the green check mark – repeat for
the other two walls.
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25. We need to constrain the horizontal position of the walls in relationship to the inside
walls of the overall structure. Let’s begin with the longer baffle walls and use the
Dimension button again and select an inside end wall and one of the construction lines,
pull off the dimension and enter in 14”. Do the same for the weir wall except use 30” for
the value. Your sketch should look similar to below:

26. Next, we need to constrain the top and bottoms of each wall. For the weir wall, we only
need to constrain the top as the bottom was snapped to the top of the floor. Use the
dimension command to constrain the top of the baffle walls 12” from the top of the
structure, the bottom of the baffle walls 12” from the top of the floor of the structure, and
the top of the weir 24” from the top of the floor. Your sketch should look similar to below:
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27. Click Finish sketch. Orient your model so you are looking into the top of the structure
and can see the three walls.
28. Use the Extrude button to extrude the walls. For the profile, choose each of the walls.
For the Direction, choose the Symmetric button. For the distance, enter in the following
formula “SPWidth - (2*WallTh)”. Click Ok. Your model should look something like below:

29. The model is now complete, and we need to prepare for export. In the Quick Access
Toolbar location, find the fx button, this will open the Parameters dialog. For each of the
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named parameters, check the Key and Export Parameters column. Click Done when
complete.
30. Next, assign the structure material. On the Quick Access Toolbar, click the pull down
that says “Generic”. At the bottom, check the box Autodesk Material Library. Click the
pull down again and choose Concrete, Precast. The model will now take on that
material.
31. In the model browser, turn off any work planes from visibility by selecting them, right
clicking, and unchecking visibility.
32. Next, we need to define the structure connection points with the Infrastructure Part
Shape Utilities. On the Environments tab click Infrastructure Part Shape Utilities – a new
ribbon tab will appear. Choose Assembly connector. In the Port Name text box type “U”
– UndergroundStructurePort will appear. Use the Select button and start by selecting a
work plane from the model browser – expand Origin and select the XY plane. Next
choose the top wall outline of the structure – a green cylinder arrow should appear
pointing upwards. Click Ok.
33. Lastly, from the Infrastructure Part Shape Utilities tab, we need to use the Export
Template button. Here you can enter a part name and choose how the model visually
appears in the graphic. This graphic will be what is used in Infrastructure Parts Editor.
Click Export button when ready.
34. The Underground Structure is now complete.

Page 29

References:
Autodesk | Civil 3D. (2017, 10 22). About the Part Catalog and Parts Lists for Pipe Networks.
Retrieved from Autodesk Knowledge Network:
https://knowledge.autodesk.com/support/autocad-civil-3d/learnexplore/caas/CloudHelp/cloudhelp/2018/ENU/Civil3D-UserGuide/files/GUID-2A52D123516A-46A4-BFA4-DD56984BC21F-htm.html
Autodesk. (2017, 10 21). Autodesk Infraworks - About the Part Editor. Retrieved from
help.autodesk.com: http://help.autodesk.com/view/INFMDR/ENU/?guid=GUID725C04D2-AF2E-41A4-835F-6FE2FB3F5DFF
Dictionary.com. (2017, 10 29). Cartesian Coordinate Sytem. Retrieved from Dictionary.com:
http://www.dictionary.com/browse/cartesian-coordinate-system

Page 30

